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END USER LICENCE AGREEMENT

This is a legal agreement between you, the end user, and da Lynchi.  Be sure to read the following agreement
before using the software.  BY USING THE SOFTWARE (REGARDLESS OF WHETHER YOU HAVE
REGISTERED THE SOFTWARE OR NOT), YOU ARE AGREEING TO BE BOUND BY THE TERMS OF
THIS AGREEMENT.  IF YOU DO NOT AGREE TO THE TERMS OF THIS AGREEMENT, DELETE ALL
COPIES OF THE SOFTWARE FROM ANY STORAGE DEVICES UPON WHICH YOU HAVE PLACED IT.

OWNERSHIP OF THE SOFTWARE

1. The software program "WheelBuilder PE" and any accompanying written materials are licensed, not sold, to
you ("Licensee") by da Lynchi for use only under the terms of this license, and are protected by United Kingdom
copyright laws, by laws of other nations, and by international treaties.

GRANT OF LICENSE

2. This license allows you to store and operate the Software on a single computer (unless otherwise specified by
terms of purchase).

3. This license is valid for use worldwide.

RESTRICTIONS OF USE AND TRANSFER

4. You may not copy the Software, except that (1) you may make one copy of the Software solely for backup or
archival purposes, and (2) you may transfer the Software to a single hard disk provided you keep the original
Software solely for backup or archival purposes. You may not copy the written materials.

5. This license is nontransferable.

6. You may not reverse engineer, decompile, disassemble, nor alter the Software.

LIMITED WARRANTY

7. da Lynchi warrants for a period of thirty (30) days from your date of purchase. Any implied warranties on the
Software are limited to 30 days. Some countries do not allow limitations on duration of an implied warranty, so
the above limitation may not apply to you.

8. DA LYNCHI DISCLAIMS ALL OTHER WARRANTIES, EITHER EXPRESS OR IMPLIED, INCLUDING
BUT NOT LIMITED TO IMPLIED WARRANTIES OF MERCHANTABILITY, FITNESS FOR A
PARTICULAR PURPOSE, AND NON-INFRINGEMENT, WITH RESPECT TO THE SOFTWARE AND THE
ACCOMPANYING WRITTEN MATERIALS. NO ORAL OR WRITTEN INFORMATION OR ADVICE
GIVEN BY DA LYNCHI, THEIR DEALERS, DISTRIBUTORS, AGENTS, OR EMPLOYEES SHALL
CREATE A WARRANTY OR IN ANY WAY INCREASE THE SCOPE OF THIS WARRANTY, AND YOU
MAY NOT RELY ON SUCH INFORMATION OR ADVICE. This limited warranty gives you specific legal
rights. You may have others, which vary from country to country.

9. DA LYNCHI'S ENTIRE LIABILITY AND YOUR EXCLUSIVE REMEDY SHALL BE, AT DA LYNCHI
CHOICE, EITHER (A) RETURN OF THE PRICE PAID OR (B) REPLACEMENT OF THE SOFTWARE
THAT DOES NOT MEET DA LYNCHI'S LIMITED WARRANTY AND WHICH IS RETURNED TO DA
LYNCHI WITH A COPY OF YOUR RECEIPT.
Any replacement Software will be warranted for the remainder of the original warranty period or 30 days,
whichever is longer. 

10. This limited warranty is void if failure of the Software has resulted from modification, accident, abuse, or
misapplication.

11. NEITHER DA LYNCHI, NOR ANYONE ELSE WHO HAS BEEN INVOLVED WITH THE CREATION,
PRODUCTION, OR DELIVERY OF THE SOFTWARE SHALL BE LIABLE FOR ANY DIRECT, INDIRECT,
CONSEQUENTIAL, OR INCIDENTAL DAMAGES (INCLUDING DAMAGES FOR LOSS OF BUSINESS
PROFITS, BUSINESS INTERRUPTION, LOSS OF BUSINESS INFORMATION, AND THE LIKE) ARISING
OUT OF THE USE OR THE INABILITY TO USE THE SOFTWARE EVEN IF DA LYNCHI HAS BEEN
ADVISED OF THE POSSIBILITY OF SUCH DAMAGES. Because some countries do not allow the exclusion
or limitation of liability for consequential or incidental damages, the above limitation may not apply to you.

12. If you have any questions concerning this Agreement or wish to contact da Lynchi for any reason, please
write: wheelbuilders@me.com
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Forward

Like many things, da Lynchi WheelBuilder PE (Personal Edition) is the result of frustration. A hub
started playing up not long alfter having a wheel rebuilt around it. A better hub would mean new
spokes and another build and truing fee. So I started wondering if this wheel building stuff was
actually as mysteriaous as I had been led to believe. Research very soon revealed enough material
to indicate that it's not really a mystery at all - but it needs practice.

And then I got side tracked. The Spoke Length Calculators that I could find all appeared to do
exactly what they are meant to do - that is to calculate spoke lengths. No surprises there. But none
of them seemed to provide an easy means of archiving and searching the details of previous builds.
So having written a few databases before I decided to write something to do just that.

The spoke length calculation has been verified against a number of other well known calculators to
be found on-line. Of 10 calculators tested, the difference between the shortest and longest spoke
answers was less than 0.7mm. WBPE’s results were within 0.2mm of the mid point of this range.

WPB on its own will not make you a wheel building expert. That you can only aspire to by building
wheels - lot's of 'em, because experience cannot be tought. If you want to build an expensive light
weight 18 spoke radial wheel for a 100Kg-plus rider then WBP will calculate the spoke lenghts for
you. It wont' stop you using or supplying the wrong wheel no matter how well you build it.

Finally, these things are never really 'finished'. It seams like there's always something more that
you think you should have added or as soon as you show it to somebody they ask for something
that you've not yet included. Projects can easily be drawn into 'feature creep' territory with the only
result being that the product never gets out the door. At some point you have to say that's it. Let's
get version one out there, take a breather, and then start thinking about what's next. So while I
work on WheelBuilder Pro, here's what I think is a good start at a free version and I hope you
enjoy using it, WheelBuilder PE.

Feel free to nudge me if you think I've got something wrong, forgotten something or there's
something you think I should include. wheelbuilders@me.com

My thanks to Mark, Chris and everyone else at Sigma Sports in Hampton Wick for their invaluable
help in putting WBP through the mill and introducing me to reality and Arup for his invaluable
advice.

WheelBuilder PE is copyright but provided free for personal use. 

Ianardo da Lynchi: 12/2010.
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GETTING STARTED

Installing WBPE

For both Mac and Windows, simply unzip the download andcopy the WheelBuilder PE folder (WBPE)
to wherever you prefer on your hard drive. The Applications / Programs folder would be a sensible
place. You can make an alias / short cut of the WBPE file and put it on your Dock or on your
desktop.

To launch, double-click the WBPE folder icon (not the WheelBuilder.USR file)

Note, that compressing the files above into a single zip file upsets the the icon layout such that
when subsequently unzipped, the files within the WBPE folder appear sorted alphabeticaly. You can
leave them that way if you wish, just be sure to understand that WBPE is the programme file and
WBPE.USR is the data file.

Minimum requirements

Mac OS X.2 or above, 50Mb free disk space, 512mb Ram.

Windows XP or above, 50Mb free disk space, 512mb Ram.
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ReadMeWBPE
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QUICK START

If you don't like reading manuals, just go straight ahead and create a new record.

• Click on the “New” button top left to create a new record.

• Fill in any details you want to record about the components you are going to use.

• Go to the Spoke Length Calculator on the right hand side of the wondow.

• Enter the number of crosses and the spoke count for either or both wheels.

• Enter the rim and hub measurements

Your spoke lengths are then calculated.

That's all there is to it really. You can use the notes field to record whatever you like about the
wheel build went; how easy was it to source the components you used for example, or how the
spoke lengths ended up in the finished wheel.

If you want to see an example, select “Create an Example” from the help menu.

If you have the components but don't know how to measure them, select “Measuring
Componetnts” from the help menu. (There's also a video available for download)

If you want to discover what “Post-build Numerical Analysis is all about, select that from the help
menu too.
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SPOKE LENGTH CALCULATOR (SLC)

NOTE:  All spoke calculations are based upon 12mm nipples. 

Front/Rear
These fields tell the Spoke Length Calculator (SLC) which wheels are being built. Either or both
checkboxes must be enabled to activate the SLC.

Number of Crosses
These fields define the "lacing pattern" or number of times each spoke crosses another. You may
only enter a single digit between zero and 4. Although not common on front wheels, different
lacing patterns are possible on either side of either wheel. A rear wheel for example may have 2 or
three crosses on the drive or right side and fewer crosses on the left side or even none at all known
as "radial".

The number of Spokes
You may only enter a whole number between 18 and 40. If you leave this field empty it will be
filled in for you if you choose a hub or a rim from the Parts List. A valid number must be present
for the spoke length calculation to proceed.

ERD Provided
Effective Rim Diameter is a critical measurement where even minor variations can greatly affect
the calculated spoke length. A figure for ERD Provided comes from the manufacturer's
specifications and can only entered by choosing a rim from the parts list. This field is write
protected so you cannot enter anything manually or overwrite the automatic figure.

ERD
The Effective Rim Diameter expected by this spoke length calculator is the length between spoke
ends when they sit just flush with the bottom of the slot in the nipple head. The figure provided by
the manufacturer of your rim may or may not correspond with this. Sometimes they may specify
NSD or Nipple Seat Diameter which is not the same thing. Always check as ERD has the most effect
on the final result.

Spoke hole diameter
This is the diameter of the holes through which the spokes must pass in the hub flanges. If you are
working with an unknown hub you should expect a number of approx 2.6mm. ( Measure the
diameter of a spoke that fits it nicely ).

PCD
Pitch Circle Diameter is the diameter of an imaginary circle that passes through the centre of the
spoke holes in the hub flanges. It is typically the same on both sides of a hub although the
calculator allows for differences.

CTF
Centre to Flange is the distance from the centre of the hub to either flange. For a front hub the
lengths are usually identical. For a rear hub they will be offset to take account of the drive
sprockets.

Spoke Length
This field, which will only be displayed if all the parameters the calculation is based upon are
present, shows the arithmetic length to two decimal places.

Nearest length
This field shows the arithmetic length rounded up or down to the nearest millimetre. You can use
this value to source your spokes.

Nearest even length
This field shows the nearest even length spoke to the arithmetic length as sometimes even lengths
are all that are available.
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THE FOLLOW UP:

Build Tolerances: 
This is your responsibility but if you are new to wheel building, you should try to achieve 0.2mm
laterally, 0.5mm radially and 0.5mm either side for dishing (1mm total).

Job Number
Job Ticket using the Notes field and the fields about spoke lengths.

HUB, RIM, SPOKES
If you are only ever going to create a few records it doesn't really matter what you enter in these
fields but if you want to search a large number of records, be consistent about what you enter. Try
to adopt a consistent naming convention about your components otherwise you might have
difficulty finding records.

Notes
The Notes field is simply a text area where you can write whatever you like, difficulties with placing
nipples into a particular deep section rim for example, or how your preferred choice of hub turned
out to be difficult to source in time available.

The recommended spoke lengths may prove difficult to source in the time you have available to
complete the build. Make a note if you decide to adjust the recommended lengths by a small
amount, usually no more than -1mm, if those lengths are more readily available.

There is no need to 'save' the Job Ticket, it is saved automatically. You can click the "New" button
to return to the SLC and create a new build you wish to. 

 RADIAL, LATERAL AND SPOKE TENSION TABLES

These tables are provided for wheel builders who use deflection and tension gauges and want a
numerical record of their finished wheels. Recording these measurements is by no means essential
for well built wheels and so the tables are placed out of normal view behind the main data entry
window. They are brought into view with the ruler button.

The upper bank of tables is for the front wheel, the lower bank for the rear wheel. The upper row in
each pair of rows is for the spokes on the left side the wheel, the lower row for the  spokes on the
right side of the wheel. Spokes are numbered with 1 as the spoke nearest to the valve hole in a
clockwise direction viewed from the right side of the wheel. All the odd numbered spokes are on
the upper row of each pair of rows and all the even numbered spokes on the lower.  Always
progress around the wheel starting from the valve hole and alternating between upper and lower
cells.

Table ‘cells’ are greyed out for spoke numbers greater than number of spokes for each wheel. Do
not use these cells. eg, for a 32 spoke wheel, spoke positions 33 to 40 will be greyed out indicating
that you have 16 spokes on either side of the wheel.

Units
The Radial and Lateral tables are in millimetres plus and minus. For spoke tension you may enter
the numbers from the deflection scale of your favourite spoke tension meter or a unit of force such
as Kgf. Since the maximum spoke tension for most rims will be less than around 150kgf, the cells
can comfortably accommodate three digits. Working in Newtons however will likely result in
needing four digits, as 1Kgf is approx. 10 Newtons (9.0665). If your rim is specced in Newtons it is
preferable to divide it by 10 and work in Kgf. 
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Range
How your measurements are displayed depends upon the tolerances you set for trueness and
spoke tension. Cells that are outside your set tolerance will be shaded bright yellow. For trueness,
set your tolerance in plus or minus millimetres remembering that ± 0.5mm is a total deviation of
1mm.

Even spoke tension throughout all spokes on each side is a characteristic of a well built wheel. It is
common practice to tension all the spokes for each side of a wheel to be within a percentage range
of the average tension of all the spokes on that side. Plus or minus 20% of the average is often
quoted and this figure is automatically entered into the “via%” field for you. Change it to whatever
you like if you want to but remember that the range is from minus  that percentage  to plus that
percentage. 20% therefore is from minus 20% to plus 20% from the average which is a range of
40%. Spoke tensions outside the specified range will display with a bright yellow background.

Maximum Rim Tension
Tension spokes too far and the rim will deform way before any damage to the spoke occurs. Either
its ‘roundness’ will suffer as flat spots develop or spoke tension can crack the rim at the spoke
hole. Rim manufacturers therefore specify a maximum spoke tension and this can be entered into
the “Rim Max” field. If the rim is specced in Newtons, divide the number by 10 and work in Kgf or
extrapolate Newtons to the deflection reading on your Spoke Tension Meter. Do not mix units! 

The Rim% field allows you to specify how close to this limit you wish to tension. eg, specifying ‘90’
means no spoke should be tensioned beyond 90% of the maximum for that rim. Spoke tensions at
or beyond this limit will display with bright red digits.

Because of the above, it is possible to see cells that are coloured with both a yellow background
and red digits. This would indicate uneven spoke tension AND spokes that are too close to the
maximum tension for the rim.

The objective is therefore to properly true and tension a wheel to your own specifications with no
yellow or red cells in any of the tables. 
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VIEWS

All Wheelbuilder PE windows are designed to be viewed on screens with a resolution of 1024 x 768
or better although 1280 x 800 or better is recommended. Windows/PC views will look approx 20%
bigger than the same view on a Macintosh computer due to their differing display architectures.
You can also adjust your default display size in the ‘View’ menu item.

  Data Entry: The Single Record button switches the view to the Data Entry view. The

Data Entry view is the default view. As it’s name implies, it’s where you do most of the interaction
with the programme, inputting data and calculating spoke lengths.

  List View:  The List View button switches the view to the List view. If you ever build

a small number of wheels then list view isn’t much of a benefit over the Data Entry view. But as the
number of records in your databases increases, navigating through them becomes tedious in Data
Entry view and so it is easier viewing multiple records together.

You can still edit the fields that are shown in List View but there are necessarily fewer fields
displayed. However, you can also sort the records listed by clicking on and of the column headers.
When you find a record of interest in the list, click into one of its fields and then click the red Data
Entry View button to see that record’s details.

New: Creates a new blank record

Find: Enters Find mode. You will be presented with what looks like a new
blank record but in fact it’s a window waiting for you to enter
whatever you want to search for. Enter your search terms into the
field or fields where you expect to find a match and hit return..

The body of records (if any) returned from a Find operation is known
as the “Found Set” and is an important concept in database
operations.

If no match is found, press the cancel button to return to the data
entry view or re specify your search terms.

Delete: Deletes the current record. For safety, there is no facility to delete
multiple or all records at the same time. If this is what you want to
achieve, create an empty clone of your database instead using the
“Save a Copy As ...” item in the File menu. If you want a selection of
records in your new clone, make the selection in the original file
using a suitable Find command, export them to a file and then import
that file into your new clone.

Navigator: The tape/DVD-like icons in the Record Navigation bar are hopefully
self evident, providing First, Last, Previous and Next functions.
However, the record number indicator in the middle is also a button
which, if clicked, presents a dialogue for you to enter a record
number.
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MENU ITEMS

Notice that many menu items have quick-key combinations assigned to them. These are key
combinations that are often quicker to use than mousing up to a menu. The key combination of
and the letter “p” (Ctrl + P on Windows) for example,  starts the print dialogue.

FILE MENU

Page Set up Selects which printer, page dimensions, scaling and paper
orientation.

Print The most important thing to remember about printing from a
database is whether you want to print all the records you currently
have selected (The Found Set), or just the single record that you are
looking at. This is chosen during the Print dialogue so make sure to
notice it or you might mistakenly print many records when you only
wanted one.

Furthermore, in the limited environment of this database, the only
printout that makes much sense is to print a list of previous wheel
builds. Printing from the Data Entry view may notbe of any great
benefit if the Notes field contains more text than you would see on a
printout. However, a version of the Data Entry window is provided in
order to accommodate the post-build measurement tables should you
wish to use it. If you are in the Data Entry screen when you choose
the Print option, you will print this version of the Data Entry screen.
If you are in List view, you will print the List view report. Neither of
these printouts are customisable.

Import Records ... Imports the contents of a file. You will be presented with a dialogue
to locate the file to import. Once imported, the records in the import
file become the Found Set. See Appendix A for the field order

Export Records ... Exports the contents of each field in each record of the Found Set.
You will be presented with a dialogue to decide on a file name,
location and format. Export as an Excel file to export with field
names. See Appendix A for the field order.

Save a Copy As ... There are three options to backing up your current data file to a
different location. The data file is the one named WBPE.USR. You can
save a copy, a compacted (smaller) copy or create a new empty data
file (Clone).

Back up your database frequently.
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EDIT MENU Which items in the Edit menu are active at any one time depends
upon what is highlighted / selected at that time.

Undo The Undo menu changes according to whether there is actually
anything to undo. If you have edited some text for example, the
Undo menu will say “Undo Typing”. If you have made a format
change, the Undo menu will say “Undo Formatting”. Undo is once-
only opportunity to reverse your last action and that last action only.
Once you make another change, you can no longer reverse any
previous alterations.

Cut Deletes whatever is the active selection whilst leaving a copy of it on
the Clipboard.

Copy Copies whatever is the active selection to the Clipboard.

Paste Pastes the contents of the Clipboard to the current location. 

Clear Deletes whatever is the active selection without leaving a copy of it
on the Clipboard.

Select All Selects everything within the active field (the field in which is the
cursor).

Find/Replace As in a word processing application, you can find and replace data
across multiple fields (including related fields) in a record or  across a
found set of records.

Spelling Check the spelling of text in a selected word or passage in a field, the
visible fields in the current record only or the visible fields in all
records in the current found set.

Export Field Contents Exports the contents of a single field in the active record to a new
file.

FORMAT MENU

The format menu behaves just as is other programmes and as you would expect provided that you
have some text selected. The one difference however is that your changes will affect only the
selected text in only the current record.

Font -

Size -

Style -

Align Text -

Line Spacing -

Text Colour -

You can also access Font, SIze, Style and Text Colour with a right-click into a field (ctrl-click).
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RECORDS MENU

New Record Create a new blank record. The ‘New’ Button does the same thing.

Duplicate Record Makes an exact copy of the current record.

Delete Record Deletes the current record

Go To Record The record number specified becomes the current record.

Show All Records If a sub set of all records is the Found Set, this command ensures
that all records in the database becomes the Found Set.

Unsort Restores the records in the current Found Set to their creation order
(the order in which they were entered in the file).

Replace Field Contents Replaces the contents of the same field the entire found set with the
contents of the field the insertion marker is in. So use it with caution!
 

Note: You can sort records in ascending or descending order of any field by
right clicking into it (ctrl-click).

VIEW MENU When first installed WBPE will display at medium size. You can
change this to your preferred size and it will be remembered when
you next relaunch it.

Small Windows are adjusted to 430 x 680 pixels

Medium Windows are adjusted to 514 x 735 pixels

Large Windows are adjusted to 612 x 914 pixels

HELP MENU “In-app” sections of this manual are available including

“Using WheelBuilder PE”

“Measuring Components”

“Post-build Numerical Analysis”

In addition you have the option to create an example record with
dummy data. To enter example data for the Post-build Numerical
Analysis, select that Help option and click the word “Example” on the
top right of the page.

Upgrades / Updates Select “About” in the Help menu and then click “Check for Updates”.
This will open a web browser window at the WBPE downloads page.

Choose “import” in the file menu of the new database and select the
old database to import records from.
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MEASUREMENTS

THE RIM

Measuring something as simple as the diameter of a wheel rim can be a surprising complicated
affair in practice. The outer edges? The inner surface? From the top of the nipple? And how do you
actually get your ruler into the right place? Roger Musson, (http://www.wheelpro.co.uk) in his book
‘The Professional Guide to Wheel Building’ solves this problem in the simplest of ways.

He recommends bonding a couple of 200mm lengths of spokes to nipples such that the threaded
end of the spokes sit just flush with the bottom of the slot in the nipple head. (This is precisely
where you want your spoke ends to finish up once the wheel has been properly trued and
tensioned)

You then thread each 200mm spoke through opposite spoke holes in the rim and measure the
length of the gap between them. The Effective Rim Diameter is then 400mm plus the gap length.
Do this several times and average the results.

It is good practice to do this every time you build a wheel! Even if you have the rim manufacturer’s
ERD figure to hand, measure it yourself to be sure that what they are referring to as ERD is what
you actually measure. If there’s a difference, use your own measurement. (Sometimes
manufacturers specify the Nipple Seat Diameter (NSD) whereas the calculations here expect the
ERD to mean the distance to the spoke ends as described above.) This might only mean a
difference of a millimetre or two but this is the most critical measurement of all. Small differences
in ERD can lead to significant differences in spoke length. So measure it as described and believe
your own figures!
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THE HUB

Pitch Circle Diameter (PCD)
The PCD is the diameter of the circle that passes through the centre of the spoke holes. It may be
different for left and right flanges. It is usually between 38mm and 67mm and is a critical
measurement so make several measurements and average the results.

Spoke Hole Diameter (SHD or ø)
SHD is the diameter of each spoke hole, usually 2.6mm

Over Lock Dimension (OLD)
OLD is the distance between the outside flats of the lock nuts and corresponds to the frame gaps
front and rear. Note that the axle itself protrudes some way beyond the OLD so as to engage with
the  drop outs. Half the OLD equates to the centre line of the hub.

Centre to Left Flange and Centre to Right Flange
Clf and Clr are the two other important measurements. They are not measured directly as it's
impossible to judge the centre line of the hub by eye. 

Instead the dimensions x and y are measured and subtracted from half the OLD to provide C and D
respectively. The measurements can be made by removing the Quick Release if attached and
dropping each side of the hub into a hole in a flat surface just big enough for the axle width. The
distance from the flat surface to the flange can then be taken with a ruler. Holding the flat face of
the over lock nut against a good straight edge of a desk or table can also be useful.

Note that spoke lengths need to be calculated for EACH flange on each hub, front and rear. Front
non-disc hubs will probably have equal length spokes on both left and right flanges. Rear hubs that
carry the drive mechanism such as a cassette will have different length spokes on the left flange
(the "non-drive" side) to the length of spokes on the right side (the "drive" side).
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NIPPLES

Note, all WheelBuilder PE spoke length calculations are based upon the use of 12mm nipples. If you
use different lengths you will need to compensate for this by adjusting the spoke lengths
recommended by WBPE.

A simple method to determine a compensation to apply for a longer nipple is to screw both a
12mm and the longer nipple each all the way on to separate spokes. The difference in the length of
the threaded end of the spoke protruding from the head of the nipple is the amount that you need
to SUBTRACT from the spoke lengths given by WBPE.

Longer DT Swiss nipples may need special consideration.
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APPENDIX A - RECORD EXPORT / IMPORT FIELD ORDER
When records are exported, the relevant WBPE database fields are exported to a plain text file in
the following order. Likewise when importing data into WBPE, you must arrange that fields are
placed in this order.

Job Number
Date
Number of spokes in the front wheel
Number of spokes in the rear wheel
Lacing pattern of the left side of the front wheel
Lacing pattern of the right side of the front wheel
Lacing pattern of the left side of the rear wheel
Lacing pattern of the right side of the rear wheel
ERD measured on the front rim
ERD measured on the rear rim
OLD Over Locknut Dimension, front
OLD Over Locknut Dimension, rear
Spoke hole diameter on the front hub flanges
Spoke hole diameter on the rear hub flanges
Front hub centre to left flange offset
Front hub centre to right flange offset 
Rear hub centre to left flange offset 
Rear hub centre to right flange offset
Front hub left Pitch Circle Diameter
Front hub right Pitch Circle Diameter
Rear hub left Pitch Circle Diameter
Rear hub right Pitch Circle Diameter
Front left spoke length exact
Front right spoke length exact
Rear left spoke length exact
Rear right spoke length exact
Front left spoke length nearest whole number
Front right spoke length nearest whole number
Rear left spoke length nearest whole number
Rear right spoke length nearest whole number
Front left spoke length nearest even number
Front right spoke length nearest even number
Rear left spoke length nearest even number
Rear right spoke length nearest even number
Build notes
Front hub used
Rear hub used
Front rim used
Rear rim used
Front spokes used
Rear spokes used
STFL Spoke Tensions Front Left
STFR Spoke Tensions Front Right
STRL Spoke Tensions Rear Left
STRR Spoke Tensions Rear Right
Time stamp
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APPENDIX B - RECOVERING DAMAGED FILES
Power failures, hardware problems, or other factors can damage a database file. It is allways good
practice to make back up copies of your important data. You can do this by copying just the file
WBE.USR, or the whole WBPE foler, to a safe backup location. If suspect that your database has
become damaged, you will need to run the recovery process on it. (You can think of the WBPE file,
the one with the folder icon, as the 'programme' or application and the WBPE.USR file as the 'Data'
file). Data corruption would occur in the .USR file not the programme file)

To recover a damaged file:

On Windows machines press Ctrl+Shift while double-clicking the application icon. Keep the
keys held down until you see the Open Damaged File window.

On Mac OS X machines press ⌘-Option while double-clicking the application icon. Keep the
keys held down until you see the Open Damaged File window.

Select the suspect data file and click open

The recovery process … creates a new database file

renames the suspect file by adding Old to the end of the filename
(WPE Old.USR)

gives the repaired file the original name  (WPE.USR)

Tells you what it did …

If you experience unusual behavior in the recovered database you should revert to a backup copy
that was made before the file became corrupt, or 

1. Recover the damaged solution file using the method described above.

2. Open the recovered file.

3. Choose File menu > Save a Copy As.

4. In the dialog box, choose compacted copy (smaller) from the Save a (Windows) or Type (Mac
OS X) drop-down list, name the file, and click Save. Give the compacted file the same filename
as the original file.

5. Make a clone of the original database and import the data from the recovered file into it.
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SPECIAL THANKS

http://www.wheelpro.co.uk:  Roger Musson is a professional wheel builder. His
eBook, ‘The Professional Guide to Wheel Building’, 5th Edition is packed with practical
advice and is a bargain at just £9 /$14. It’s a simple download from his web site and is
must read for anyone interested in wheel building.  Do nothing further until you have
bought it and read it several times! 

http://www.sigmasport.co.uk: Thanks to the workshop guys at Sigma Sport in
Hampton Wick for bringing some reality into my flights of fancy!

ACKNOWLEDGEMENTS

Any internet search associated with wheel building / truing will present a number of
choices for spoke length calculation. The following are perhaps the most popular ...

http://www.dtswiss.com: 

http://www.sapim.com:

http://www.sheldonbrown.com: No one can even mention bicycles without visiting
this famous fount of knowledge. He has links to a number of spoke length calculators
too.

http://en.wikipedia.org/wiki/Wheelbuilding: The famous on-line encyclopaedia has
a section on wheel building including an explanation of the geometry involved in the
spoke length calculation.
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